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Preface

This manual describes how to use the Oracle Email Migration Tool packaged with 
Oracle Collaboration Suite, and provides information about the Migration Tool, the 
Migration Setup Wizard, and the tasks you perform to migrate e-mail systems to the 
Oracle Email component of Oracle Collaboration Suite.

This preface contains these topics:

■ Audience

■ Organization

■ Related Documentation

■ Conventions

■ Documentation Accessibility
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Audience
The Oracle Email Migration Tool Guide is intended for system administrators, 
e-mail administrators, and people involved in planning e-mail systems for 
organizations migrating users to Oracle Collaboration Suite from Oracle eMail 
Server 5.2.x, Microsoft Exchange 5.0 and 5.5, Lotus Domino Server R5, GroupWise, 
and Samsung Contact (formerly OpenMail). This document is intended to help 
perform the following tasks:

■ Premigration Tasks

■ Migrating Users

■ Migrating Data

■ Post Migration Tasks

To use this document, you must have an understanding of Oracle Email server 
administration.

Organization
This document contains:

Chapter 1, "Introduction to Oracle Email Migration Tool"
Introduces the Migration Tool and provides an overview of the migration process.

Chapter 2, "Migration Planning and Using the Oracle Email Migration Tool"
Explains planning for migration and focuses on configuration, plug-ins, and routing 
reconfiguration planning.

Chapter 3, "Migration Tasks"
Describes pre-migration, migration, and post-migration tasks for e-mail.

Appendix A, "Plug-In Generated File Formats"
Provides file formats and examples of generated files including user list, 
distribution lists, public aliases, shared folders, and server-side rules.

Appendix B, "API Architecture"
Provides guidelines for developing plug-ins to migrate other third party e-mail 
systems.
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Related Documentation
For more information, see these Oracle resources Oracle Collaboration Suite Release 
9.0.4 documentation set:

■ Oracle Collaboration Suite Concepts and Planning Guide

■ Oracle Collaboration Suite Configuration Handbook

■ Oracle Collaboration Suite Installation Guide for AIX-Based Systems and HP Tru64 
UNIX

■ Oracle Collaboration Suite Installation Guide for Solaris, HP, and Linux

■ Oracle Collaboration Suite Installation Guide for Windows

■ Oracle Collaboration Suite Release Notes for Solaris

■ Oracle Collaboration Suite Release Notes for Windows

■ Oracle Email Administrator’s Guide

Printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register 
online before using OTN; registration is free and can be done at

http://otn.oracle.com/membership/

If you already have a user name and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at

http://otn.oracle.com/documentation/

Conventions
This section describes the conventions used in the text and code examples of this 
documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in 
a glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle10i Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.

UPPERCASE 
monospace 
(fixed-width) 
font

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width) 
font

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to open SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, 
and location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED 
initialization parameter to true.

Connect as oe user.

The JRepUtil class implements these 
methods.

lowercase 
italic 
monospace 
(fixed-width) 
font

Lowercase italic monospace font 
represents placeholders or variables.

You can specify the parallel_clause.

Run Uold_release.SQL where old_
release refers to the release you installed 
prior to upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line 
statements. They are displayed in a monospace (fixed-width) font and separated 
from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two 
or more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the 
code that are not directly related to 
the example

■ That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .
 .
 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

SQL> SELECT NAME FROM V$DATAFILE;
NAME
------------------------------------
/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf
9 rows selected.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

acctbal NUMBER(11,2);
acct    CONSTANT NUMBER(4) := 3;
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Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password
DB_NAME = database_name

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the 
order and with the spelling shown. 
However, because these terms are not 
case sensitive, you can enter them in 
lowercase.

SELECT last_name, employee_id FROM 
employees;
SELECT * FROM USER_TABLES;
DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names 
of tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;
sqlplus hr/hr
CREATE USER mjones IDENTIFIED BY ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. To start the Database Configuration Assistant, 
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools > 
Database Configuration Assistant.

File and directory 
names

File and directory names are not case 
sensitive. The following special characters 
are not allowed: left angle bracket (<), 
right angle bracket (>), colon (:), double 
quotation marks ("), slash (/), pipe (|), 
and dash (-). The special character 
backslash (\) is treated as an element 
separator, even when it appears in quotes. 
If the file name begins with \\, then 
Windows assumes it uses the Universal 
Naming Convention.

c:\winnt"\"system32 is the same as 
C:\WINNT\SYSTEM32

Convention Meaning Example
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C:\> Represents the Windows command 
prompt of the current hard disk drive. 
The escape character in a command 
prompt is the caret (^). Your prompt 
reflects the subdirectory in which you are 
working. Referred to as the command 
prompt in this manual.

C:\oracle\oradata>

Special characters The backslash (\) special character is 
sometimes required as an escape 
character for the double quotation mark 
(") special character at the Windows 
command prompt. Parentheses and the 
single quotation mark (’) do not require 
an escape character. Refer to your 
Windows operating system 
documentation for more information on 
escape and special characters.

C:\>exp scott/tiger TABLES=emp 
QUERY=\"WHERE job=’SALESMAN’ and 
sal<1600\"
C:\>imp SYSTEM/password FROMUSER=scott 
TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name. The 
home name can be up to 16 alphanumeric 
characters. The only special character 
allowed in the home name is the 
underscore. 

C:\> net start OracleHOME_NAMETNSListener

Convention Meaning Example
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/

ORACLE_HOME 
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3, 
when you installed Oracle components, 
all subdirectories were located under a 
top level ORACLE_HOME directory. For 
Windows NT, the default location was 
C:\orant.

This release complies with Optimal 
Flexible Architecture (OFA) guidelines. 
All subdirectories are not under a top 
level ORACLE_HOME directory. There is a 
top level directory called ORACLE_BASE 
that by default is C:\oracle. If you 
install the latest Oracle release on a 
computer with no other Oracle software 
installed, then the default setting for the 
first Oracle home directory is 
C:\oracle\orann, where nn is the 
latest release number. The Oracle home 
directory is located directly under 
ORACLE_BASE.

All directory path examples in this guide 
follow OFA conventions.

Refer to Oracle10i Database Platform Guide 
for Windows for additional information 
about OFA compliances and for 
information about installing Oracle 
products in non-OFA compliant 
directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example
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Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.
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1
Introduction to Oracle Email Migration Tool

This chapter provides an overview of the Oracle Email Migration Tool.

This chapter contains these topics:

■ What Is the Oracle Email Migration Tool?

■ Who Uses the Oracle Email Migration Tool?

■ Overview of the Migration Process
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What Is the Oracle Email Migration Tool?
The Oracle Email Migration Tool is a Java tool that migrates users to the Oracle 
Email component of Oracle Collaboration Suite from Oracle eMail Server 5.2.x, and, 
using plug-ins developed for each third party e-mail system, Microsoft Exchange 
5.0 and 5.5, Lotus Domino Server R5, Novell GroupWise 6.0, and Samsung Contact 
7.1 (formerly OpenMail).

The Migration Tool can be installed on and run from either the source, target, or 
other intermediate system.

To perform a migration, a system administrator requires the following:

■ The base Migration Tool

■ A plug-in developed specifically for the source e-mail server

■ System administrator privileges on the source e-mail server

The plug-in communicates with the source e-mail system to extract data from the 
source message store, which it saves in a format understood by the Migration Tool. 
Once the required files are generated, the Migration Tool reads the files and 
migrates them to Oracle Email. The plug-in and the Migration Tool communicate 
through an API.

Oracle Email Migration Tool Features
Features of the Migration Tool include:

■ Two-phase migration, done over a period of weeks prior to the final migration, 
facilitates the overall migration process of a large scale migration

■ E-mail notifications of new account creation and migration completion provide 
feedback to users

Note: Plug-ins for the preceding source e-mail systems are 
packaged with the Migration Tool.

See Also:

■ Appendix B, "API Architecture" for information about APIs

■ "Installing the Migration Tool" on page 3-3 for directory 
information
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Who Uses the Oracle Email Migration Tool?
The Oracle Email Migration Tool is designed specifically to migrate large mail 
systems, such as:

■ Corporate installations that generally have a few thousand to hundreds of 
thousands of users with large mailboxes (tens to hundreds of megabytes).

■ Internet service providers that generally have a large number of users (millions) 
with small mailboxes (a few hundred kilobytes).

Overview of the Migration Process
E-mail migration is an intricate process. It requires migration of account 
information, including user names, public aliases, distribution lists, and server-side 
rules; data, including messages, folders, and shared folders; and Web client address 
books. Additionally, the migration process requires changes to the Simple Mail 
Transfer Protocol (SMTP) routing. Migrating a large e-mail system with minimal 
downtime is a challenging task.

Migrating a mail system involves migrating account information and migrating 
data, and routing new and future messages to the target Oracle Email server.

The migration process includes performing the following tasks:

1. Run the Migration Setup Wizard to configure the migration

2. Extract directory information from the source system

3. Load information into the Migration Tool and migration repository

4. Create users on Oracle Email

5. Create batches of users

6. Migrate data

7. Verify the migration

The Migration Tool performs the following tasks:

■ Creates new user accounts on the target Oracle Email server and defines user 
name creation policies on the target system

■ Consolidates domains

■ Maintains mail delivery throughout the migration process to eliminate 
downtime
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■ If there is a data migration error for a particular account, it maintains mail 
delivery to the user

This section contains the following topics:

■ Migrating Accounts

■ Migrating Data

Migrating Accounts
The Migration Tool extracts account information, including user names, public 
aliases, distribution lists, and server-side rules, from the source directory server or 
user profiles file and places it into the target Oracle Email system and the target 
Oracle Internet Directory, as shown in Figure 1–1.

Figure 1–1 Account Migration

You can choose to retain the user names from the source system, or direct the 
Migration Tool to generate new target user names based on rules you create.

Note: The objects that can be migrated depend upon the source 
system. Not all plug-ins support migrating all objects.

See Also: "Step 10: Specifying New Account User Names" on 
page 3-31 for information on generating new target user names

Oracle
Internet

Directory

Oracle Email
Migration Tool

Source Directory or
User Profiles File

Target 
Oracle Email 

Message Store
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Migrating Data
Migrating user data is a major part of migration and involves the most resources of 
the system on which the Migration Tool is installed. Data migration is also the most 
time consuming part of a system migration and, for large e-mail systems, 
performing a two-phase migration can help to minimize down time. Batching users 
is another way to efficiently manage the time needed to migrate data.

The following operations occur during data migration:

■ Messages, folders, and shared folders are migrated

For shared messages, a copy of each message is inserted into the database and a 
pointer is provided for every recipient of the same message, as opposed to 
having a copy of the message sent to each recipient. This can potentially save an 
enormous amount of disk space that would otherwise be taken up by duplicate 
e-mail messages.

■ Server-side rules are migrated

■ New messages are routed to Oracle Email

■ Successful migration is verified

The Migration Tool migrates data using either MBOX or IMAP-based migration.

MBOX-Based Migration
MBOX-based migration is the migration process used in a plug-in-based migration. 
Where a plug-in does not exist for a source system, other techniques, such as 
IMAP-based migration, are used.

The Migration Tool plug-in creates a collection of MBOX files for each user in a 
staging directory. E-mail folders are represented by separate MBOX files, and 
messages are appended to the file by the plug-in.

See Also:

■ "Performing a Two-Phase Migration" on page 3-43 for more 
information about pre-migration

■ "Creating Batches" on page 3-40 for more information about 
batching users

See Also: "Verifying Migration" on page 3-46 for more 
information about verification
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An overview of the MBOX-based migration process is shown in Figure 1–2

Figure 1–2 Overview of an MBOX-Based Migration

IMAP-Based Migration
If there is no plug-in available for the source e-mail system, an IMAP-based 
migration can be employed.

During an IMAP-based migration, the Migration Tool extracts the data from the 
source e-mail system message store and places it directly into the target e-mail 
system message store, as shown in Figure 1–3.

Note: Because MBOX-based migration can generate a tremendous 
amount of data, an intermediate computer system may be required 
for storage.

See Also: "Step 1: Specifying Mail System Objects" on page 3-8 for 
information on selecting a migration option

Target Oracle
Email Store

and Migration
Tool Repository

Source
Directory

Repository

Source
Message

Store

Oracle Email
IMAP Server

Oracle
Internet

Directory

Migration
Setup
Wizard

Oracle
Email

Migration
Tool

Source
System
Plug-in

MBOX Files

Messages and 
Folders Legacy

API

Legacy
API



Overview of the Migration Process

Introduction to Oracle Email Migration Tool 1-7

Figure 1–3 Overview of an IMAP-Based Migration

Note: As long as you have a plug-in, MBOX-based migration can 
be used in an IMAP-supported source e-mail server to avoid source 
password requirements.
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2
Migration Planning and Using the Oracle

Email Migration Tool

This chapter provides migration planning information.

This chapter contains these topics:

■ Requirements Before Migration

■ System Requirements

■ Configuration Planning

■ Using the Oracle Email Migration Tool



Requirements Before Migration

2-2 Oracle Email Migration Tool Guide

Requirements Before Migration
Before starting a migration, at least one instance of Oracle Collaboration Suite and 
Oracle Internet Directory must be installed on the target system.

Know something about how the enterprise is organized, including various divisions 
within the enterprise, organization of employees and geographical locations, and 
the various work groups that may be in place. Try to migrate groups of users in a 
logical manner according to the organization of the enterprise, in order minimize 
any disruptions in communication between members of the same organizational 
unit.

Gather some preliminary information about the migration, including target domain 
structure and user namespace, and source domain structure and directory source. 
Also, be familiar with the user LDAP tree, as you will need to reference this 
information frequently during the migration process.

Depending upon what source e-mail system you are migrating from, certain 
requirements must be met for each.

This section contains the following topics:

■ Preparing for a Microsoft Exchange Migration

■ Preparing for a Lotus Notes Migration

■ Preparing for a Novell GroupWise Migration

■ Preparing for a Samsung Contact Migration

Preparing for a Microsoft Exchange Migration
This section contains information for performing a migration from a Microsoft 
Exchange 5.0 or 5.5 source system.

This section contains the following topics:

■ Microsoft Requirements

■ Creating an Administrator Profile

■ Using Statistics Task to Estimate Disk Space Requirements (Optional)

Microsoft Requirements
Microsoft Outlook 97, Microsoft Outlook 98, or Microsoft Outlook 2000, and 
Microsoft Exchange Administrator must be installed on the machine where you 
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want to generate the various files (such as user list, MBOX, and shared folders) if 
migrating from Microsoft Exchange to Oracle Email.

The following Microsoft Exchange Server Services must be configured and set up 
properly:

■ Microsoft Exchange Internet Mail Service

■ Microsoft Exchange Information Store

■ Microsoft Exchange System Attendant

■ Microsoft Exchange Event Service

■ Microsoft Exchange Directory Service

Creating an Administrator Profile
If your source e-mail system is Microsoft Exchange, perform the following steps on 
the system on which the source e-mail system is installed to create an administrator 
profile:

1. Ensure that Microsoft Outlook is installed on the system and is operating 
correctly.

2. Create a profile using Microsoft Outlook.

1. Choose Start > Settings > Control Panel from the Windows NT task bar.

2. Double-click the Mail icon.

3. Click Show Profiles > Add.

Notes:

■ If you are migrating from a Microsoft Exchange source e-mail 
system and running the Migration Tool on a machine other 
than the one upon which Microsoft Exchange is installed, 
ensure that Microsoft Outlook and Microsoft Exchange 
Administrator are installed on the machine from which you are 
running the Migration Tool.

■ A user profile file cannot be generated from a machine where a 
Microsoft Exchange e-mail client is not installed.

■ Users with X.400 addresses are not migrated.
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4. Select Microsoft Exchange Server and enter a name in the Profile Name 
field. Click Next.

5. Enter the name of the server in the Microsoft Exchange Server field.

6. In the Mailbox field, enter the name of an administrator.

3. The profile information for the source e-mail system is entered using the 
Migration Setup Wizard.

Using Statistics Task to Estimate Disk Space Requirements (Optional)
To use Statistics Task to estimate disk space requirements, run it on the system on 
which Microsoft Exchange is installed.

To run Statistics Task, enter the following command using a Windows DOS prompt:

msplugin.exe statistics_file=file_name domain=domain_name

Preparing for a Lotus Notes Migration
When migrating from Lotus Domino server R5 to Oracle Collaboration Suite, 
release 9.0.4, use the Lotus Notes plug-in with the Migration Tool. The plug-in 
works with Lotus Domino version 5.0.8, or higher.

The following tasks are not supported by the Lotus Notes plug-in:

■ Extract and migrate server-side rules

■ Extract the public aliases files

■ Extract shared folders

This section contains the following topics:

■ Lotus Notes Plug-in Requirements

■ Other Lotus Notes Migration Information

See Also: "Step 2: Configuring Source Plug-ins" on page 3-9

Note: Users with X.400 addresses are not migrated.

See Also: Table 2–1, "Source E-mail System and Migration Tasks 
Supported" for information about tasks supported by the plug-in
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Lotus Notes Plug-in Requirements
Ensure that the following requirements are met before running the Lotus Notes 
plug-in:

■ Lotus Notes must be installed on the machine on which the plug-in is run

■ All users have an internet address set for them in the Lotus Domino directory

■ If you want to perform an MBOX-based migration, the plug-in assumes that 
there is one user who has administrator privileges to read the contents of every 
user’s mail file

■ If the Migration Tool is used to create base accounts on Oracle Collaboration 
Suite, the Lotus Domino LDAP server must be running and allow anonymous 
binds

Other Lotus Notes Migration Information
If an MBOX-based migration is used for migrating from a Lotus Domino server, and 
there are messages on the Lotus Domino server that use multibyte character sets, 
the plug-in extracts all multibyte data in the UTF-8 character set. When viewing 
such messages through mail browsers, it might be necessary to set the view 
character set to UTF-8 to see the messages correctly.

The Lotus Notes plug-in migrates a user’s Shared, Private, and Shared, private on 
first use folders but does not migrate the user’s Shared, desktop private on first 
use folders.

Folder names that contain the forward slash character (/) are renamed upon 
extraction by the plug-in, replacing the forward slash with an underscore character 
(_). For example, a folder in Lotus Notes named my/folder will be renamed to 
my_folder.

The Lotus Notes plug-in is currently available only on Microsoft Windows NT but 
can be used to migrate from a Lotus Domino server running on any platform.

See Also: Lotus Domino documentation for instructions 
regarding how to start this server
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Preparing for a Novell GroupWise Migration

This plug-in works with the Novell GroupWise server 6.0.

The following tasks cannot be performed by the Novell GroupWise plug-in:

■ Making routing changes for the users

■ Generating user profile files

Novell GroupWise Plug-in Requirements
■ If the Migration Tool is used to create base accounts on Oracle Email, the Novell 

GroupWise LDAP server must be running and allow anonymous binds

■ NDS (eDirectory 8.6) with Novell GroupWise 6.0, or higher

■ MTA and POA of the Novell GroupWise server installation process must be 
running

■ The Novell GroupWise client 6.0.2 patch must be applied on the system from 
which Migration Tool is invoked

■ Administrator profile name, password, tree name, and the context (as explained 
in the configuration parameter file)

■ Ensure that the Novell Default Settings profile contains the Novell GroupWise 
Address Book service

Locate the Novell Default Settings profile in Windows by choosing Start > 
Settings > Control Panel > Mail > Show Profiles (the profile is added 
automatically when the GroupWise client is installed on the Windows system). 
If the profile does not contain the service, add it to the profile.

Note: The Novell GroupWise plug-in is currently available only 
on Microsoft Windows NT and with the Novell GroupWise 6.0.2 
client.

See Also: Table 2–1, "Source E-mail System and Migration Tasks 
Supported" for information about tasks supported by the plug-in

Note: NDS is a Novell directory service also known as eDirectory. 
In this document NDS and eDirectory are used interchangeably.



Requirements Before Migration

Migration Planning and Using the Oracle Email Migration Tool 2-7

■ Users must set up proxy access for the administrator

The GroupWise administrator must be able to access (proxy) all users on the 
GroupWise system.

To grant proxy access to the GroupWise administrator:

1. Log in as a GroupWise user.

2. Choose Tools > Options > Security > Proxy Access.

3. Click Addressbook adjacent to the Name field.

4. Choose the GroupWise administrator’s name from the Novell GroupWise 
Address Book (Novell GroupWise Address Book is the GroupWise system 
address book that holds all users in the GroupWise domain).

5. Select Mail/Phone for read access.

6. Click OK to grant proxy access to the GroupWise administrator.

To ensure that proxy access is available to the GroupWise administrator:

1. Log in as the GroupWise administrator.

2. Choose File > Proxy.

3. A window displays that contains the name field and Proxy drop-down list.

4. Click Address Book and choose a user who has granted proxy access to the 
GroupWise administrator.

5. Click OK.

Preparing for a Samsung Contact Migration
This plug-in works with Samsung Contact Server 7.1.0.

The following tasks cannot be performed by the Samsung Contact plug-in:

■ Extracting bulletin boards

■ Extracting and migrating server-side rules

■ Extracting shared folders

■ IMAP-based migration

See Also: Table 2–1, "Source E-mail System and Migration Tasks 
Supported" for information about tasks supported by the plug-in
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The following requirements must be met in order to ensure a successful migration:

■ Ensure that the Remote Client Interface service is running on the Samsung 
Contact server

■ All users on the Samsung Contact server must have the administrator user as a 
real designate

Use the Samsung Contact Java Windows client and choose Tools > Preferences 
> Designates.

a. Click New.

b. Select Designate and enter the name of the administrator in the form of the 
Personal name in the Samsung Contact system directory.

c. In the Access Area & Capabilities window give minimum access 
permissions in the following list boxes:

– Inbox : R

– Drafts : R

– Sent : R

– Filing Cabinet : R

– Bulletin Board : R

– Address Book : R

– Personal Directory : R

– Configuration : R/M

– Select the Personal, Private, and Confidential boxes

d. You can specify start and expiry dates or they can be left blank to allow for 
unlimited time for designate access.

e. Click Apply then click OK (for client version 7.5.0 and earlier).

f. Click OK (for client version later than 7.5.0).

■ Ensure that users who are to be migrated have an SMTP internet address

■ Ensure that the system where the Migration Tool is running has a swap space of 
at least 2 GB
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System Requirements
The Migration Tool can be run on either the source system, an intermediate system, 
or the target system. Parallel instances of the Migration Tool can be run, as well, on 
the different locations.

This section describes the following system requirements for the machine on which 
the Migration Tool is running:

■ Memory

■ Disk Space

■ Network Bandwidth

■ Intermediate Storage of Data During Migration

Memory
The amount of memory required to perform a migration is dependent upon such 
variables as the volume of data to be migrated, the profile of the message store, 
concurrency of the process, and size of messages. As a very general guideline, the 
minimum memory requirement is 512 megabytes (MB) of random access memory 
(RAM).

Disk Space
The disk space requirement is:

■ 300 MB for migrating 10 users concurrently from MBOX, assuming a quota of 
20 MB for each user (including all the intermediate store files)

■ 70 MB for migrating from IMAP

Note: The Microsoft Exchange plug-in has a feature called 
Statistics Task that you can use to estimate your disk space 
requirements if you are migrating from a Microsoft Exchange 
source e-mail system. This feature is available after you install the 
Migration Tool.

See Also: "Using Statistics Task to Estimate Disk Space 
Requirements (Optional)" on page 2-3 for information about using 
the Statistics Task feature
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Network Bandwidth
The Migration Tool network bandwidth requirements are the same as those for 
IMAP4 clients, although, for high speed migrations, more bandwidth is required. 
Oracle Corporation recommends 100 megabits per second (Mbps).

Intermediate Storage of Data During Migration
During an MBOX-based data migration, sufficient disk space must be available for 
intermediate storage to hold all of the e-mail of all the users being migrated 
together.

Configuration Planning
Configuration planning involves the following:

■ Choosing the Migration Option

■ Routing Reconfiguration Planning

■ Supporting Different Character Sets

■ Reconfiguring Heap Size

Notes:

■ Migration operates efficiently on a local area network (LAN) 
with a bandwidth of at least 10 Mbps.

■ If you are performing an MBOX-based migration, a network 
connection is not always necessary. Once the MBOX files are 
extracted from the source system, they can be transferred to the 
target system through tape or disc transfer.

Note: The Migration Tool does not delete generated MBOX files.

See Also: Oracle Collaboration Suite Installation Guide for Windows 
for Oracle Email sizing guidelines
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Choosing the Migration Option
Table 2–1 lists the various source e-mail systems supported by the Oracle Email 
Migration Tool the migration tasks supported by each plug-in.

Choose one of the following options for data migration:

■ IMAP-based migration for data migration through standard protocols

■ MBOX-based migration, where a plug-in exists for the source system

For each of these types of migrations, you can choose to retain your source system 
user names or have the Migration Tool generate new target user names using rules 
you create.

Table 2–1 Source E-mail System and Migration Tasks Supported

Source E-mail System Migration Tasks Supported

Microsoft Exchange 5.0 Account creation, MBOX-based data migration, distribution 
lists, shared folders, public aliases, and server-side rules

Microsoft Exchange 5.5 In addition to the tasks supported by the Microsoft Exchange 
5.0 plug-in, IMAP-based data migration

Lotus Domino Server R5 Account creation, MBOX and IMAP-based data migration, and 
distribution lists

Novell GroupWise 6.0 Account creation (from an LDAP server information source), 
MBOX and IMAP-based data migration, distribution lists, 
shared folders, and public aliases

Samsung Contact Account creation using a User Profile file, MBOX-based data 
migration, distribution lists, and public aliases

Other Mail Systems All migration tasks are supported, however none of the 
extraction options in "Step 1: Specifying Mail System Objects" 
are enabled. You must provide files for each of the mail system 
objects you want to migrate according to the formats in 
Appendix A, "Plug-In Generated File Formats".

Note: Either migration option can be used to migrate from a 
Microsoft Exchange 5.5 source e-mail systems.
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Routing Reconfiguration Planning
The mail system is always available to a user during data migration. Prior to 
migrating a user’s data, the Migration Tool routes all of the user’s new mail to 
Oracle Email. The user can still access old mail on the source account until data 
migration is complete.

Once data migration is complete for a user, an e-mail notification is sent to the user's 
new account stating that migration is complete and that old and new e-mail can be 
accessed in the new Oracle Email account.

If an error occurs during data migration, the user’s e-mail continues to be routed to 
the user’s new account. If the Migration Tool fails to route the user, the migration 
fails.

Supporting Different Character Sets
See the Oracle Email Administrator’s Guide for information about configuring the 
Oracle Email database to support different character sets.

Reconfiguring Heap Size
The size of the heap is an important factor when deciding upon the number of users 
to migrate concurrently.

The default heap size specified in the migrate.sh (UNIX) and migrate.cmd 
(Windows NT) files is:

■ Initial heap size: 256 MB

■ Maximum heap size: 512 MB

If running on UNIX, heap size is specified in migrate.sh as follows:

exec $JRE -Xms256m -Xmx512m

If running on Windows NT, heap size is specified in migrate.cmd as follows:

"%JREHOME%\bin\java" -Xms256m -Xmx512m

Note: If you receive an Unable to start directory services error 
message from the Microsoft Exchange plug-in, the error is logged in 
the ORACLE_HOME/oes/migration/log directory.
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You must add 8 MB to the minimum heap size for every user that you want to 
migrate concurrently. The formula is 256 + 8 * N, subject to a maximum of 1 GB, 
where N is the number of users you want to migrate concurrently.

For example, to migrate 50 users concurrently, the maximum heap size must be set 
to 656 MB (256 + 8 * 50).

The ideal maximum heap size is 50% of the amount of total RAM on the target 
system.

Once you determine the heap size, Oracle Corporation recommends that you set the 
minimum value of the heap to the same size specified in the maximum value. 
Continuing with the preceding example, the parameter is set as follows:

-Xms656m -Xmx656m

Using the Oracle Email Migration Tool
The Migration Tool has various menu bar selections and methods for viewing 
information about users, source domains, batches, and migration status.

Initially, all menu selections except File > Migration Setup are disabled. You must 
run the Migration Setup Wizard at least once for the directory tree on the left side of 
the screen to be populated and the menu selections to be available.

The Migration Setup Wizard stores migration parameters in the database every time 
you run the wizard. The Migration Setup Wizard picks up the prior settings from 
the database each time it is run.

This section contains the following topics:

■ Overview of the Oracle Email Migration Tool Screen

■ Displaying User, Domain, Batch, and Migration Status Information

■ User States During Migration

■ Tuning for Performance

■ Viewing Log Files

See Also: "Advanced Migration Tool Configuration" on page 3-16 
for information about specifying a number of users to migrate 
concurrently

See Also: "Task 3: Setting Up a Migration Session" on page 3-7 for 
information about the Migration Setup Wizard
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Overview of the Oracle Email Migration Tool Screen
This section contains an overview of the Migration Tool screen.

This section contains the following topics:

■ Migration Tool Screen Menu Selections

■ Migration Tool Screen Fields

Migration Tool Screen Menu Selections
Figure 2–1 shows the menu selections on the Migration Tool screen.

Figure 2–1 Migration Tool Screen Menu Selections

■ File: The File menu contains the following selections:

– Migration Setup: Launches the Migration Setup Wizard

If the Migration Tool is being run for the first time or if you have cleared the 
migration parameters, a message dialog will display saying, "There are no 
instances found. Click OK to continue." Clicking OK will launch the 
Migration Setup Wizard.

– Load Users: Loads user information into the migration repository for later 
retrieval

– Create Batch: Displays a screen in which you enter the type of batch that 
you want to create.

– Exit: Shuts down the Migration Tool. Any ongoing migrations are canceled. 
No rollback or state saving is performed.

■ Edit: The Edit menu contains the following selections:

– User Details: Displays a screen in which you enter the source user name for 
the user whose details you want to edit

See Also: "Creating Batches" on page 3-40 for more information 
about creating batches
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– Migration Parameters: Displays a screen in which you can edit various 
migration parameters

– Clear Migration Parameters: Clears the migration parameters stored in the 
migration repository. After clearing the migration parameters, the only 
menu options enabled are Migration Setup and Exit.

■ Extract: The Extract menu selections generate the following files in the 
Migration Tool files directory by extracting data from the source system as 
metadata to control the migration process:

– Users: The users.xml file

– Public Aliases: The public_aliases.ldif file

– Distribution Lists: The distribution_lists.ldif file

– Shared Folders: The shared_folders.ldif file

– User Profiles: The user_profiles.ldif file

■ Migrate: The Migrate menu contains the following selections:

– Create Users on Oracle: Starts the migration of user accounts to the target 
Oracle Email server

– Migrate Shared Folders: Starts the migration of shared folders

– Migrate Public Aliases: Starts the migration of public aliases

Note: You can also select a user from the directory tree to modify 
that user’s details.

See Also: "Task 4: Migrating Users to Oracle Email" on page 3-33 
for more information about editing user details

See Also: Figure 3–20, "Modify Migration Parameters Screen" on 
page 3-45

Note: If you are extracting a user list file for a domain such as 
oracle.com, the file is generated in the ORACLE_HOME/oes
/migration/files/com/oracle directory.
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– Migrate Distribution Lists: Starts the migration of distribution lists

– Pre-Migrate User Data: Starts premigration of user data

– Migrate User Data: Starts the migration of user data

– Migrate Address Book: Starts the migration of users’ WebMail address 
books

– User Status: Displays a user’s current migration status

– Verify New Accounts: Displays the Verification screen and gives 
information about an individual user’s migration status by comparing the 
source and target accounts

– Cancel Migration: Cancels data migration. No rollback is performed and 
migration is terminated immediately

■ Help: The Help menu contains the following selections:

– Contents: Displays the online help

– About: Displays information about the release of the Migration Tool

Migration Tool Screen Fields
Figure 2–2 shows the right side of the Migration Tool screen when the Migration 
Instance node is selected.

See Also: "Performing a Two-Phase Migration" on page 3-43 for 
more information about pre-migrating user data

See Also: "Verifying Migration" on page 3-46 for more 
information about verification
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Figure 2–2 Migration Tool Screen Fields

■ The number of users currently migrating is displayed at the top of the section

■ Migrating Users: Displays the Domain, Batch, and User Name of users that are 
in a current state of migration

■ User Details: Displays user details of a user selected from the User Name 
column of the Migrating Users field

Displaying User, Domain, Batch, and Migration Status Information
You can display user, domain, batch, and migration status information using the 
Migration Tool screen. You can also edit the scheduled start time for migrating a 
batch using the Migration Tool screen.

This section contains the following topics:

■ Viewing Domain, Batch, and User Information

■ Displaying Source Domain Information and Migration Status

Note: When more than one Migration Tool instance runs against a 
single repository, each instance selects users independently. The 
Migration Instance for a particular instance shows only the users 
that are being migrated by that instance. Users listed in the 
directory tree on the left side of the window might not be listed in 
the Migrating Users field. If you select a user from the directory 
tree and find that their status is Migrating, it means that the user is 
being migrated by another instance.
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■ Displaying Batch Information and Migration Status

■ Displaying User Information and Status from the Directory Tree View

Viewing Domain, Batch, and User Information
You can expand the various nodes of the directory tree on the left side of the 
Migration Tool screen to display specific information.

■ When you expand MigrationInstance, all the source domains display

■ When you expand a domain, all the batches in the domain display

■ When you expand a batch, all the users belonging to the batch display

Displaying Source Domain Information and Migration Status
All the domains on the source system you want to migrate are listed under 
MigrationInstance in the directory tree on the left side of the Migration Tool screen. 
To view the information and migration status for a particular source domain, as 
shown in Figure 2–3, select the source domain.

Figure 2–3 Migration Tool Screen with Source Domain Information Displayed

The following information displays:

■ Name of Source Domain being displayed

■ Status (Pending, Migrating, Done, or Failed)

■ Number of batches in the domain

■ Number of users in the domain

■ Scheduled start time of first batch

■ Scheduled start time of last batch
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Displaying Batch Information and Migration Status
To monitor batch information, expand a domain to view the batches in the domain. 
Select a batch name to view information and migration status, as shown in 
Figure 2–4.

Figure 2–4 Migration Tool Screen with Batch Information Displayed

When you select a batch from the directory tree on the left side of the Migration 
Tool screen, the details for the selected batch display on the right side, showing the 
following information:

■ Name of the Source Batch

■ Domain to which the batch belongs

■ Status (Pending, Migrating, Done, Premigration Done, Premigration Failed, or 
Failed)

■ Number of Users in the batch

■ Scheduled start time (you can edit the date and time field and click Schedule 
to save the changes)

■ Users migrated (the percentage of users migrated)

Note: If a single user in a batch fails to migrate, the entire batch is 
marked as Failed and must be rescheduled for migration. Users 
that migrated successfully are not migrated a second time.

See Also: "Creating Batches" on page 3-40 for more information 
about batches
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Displaying User Information and Status from the Directory Tree View
To view all the users belonging to a particular batch, expand the batch. To view a 
specific user’s information and migration status, as shown in Figure 2–5, click their 
user name.

Figure 2–5 Migration Tool Screen with User Information Displayed

When you select a user from the directory tree on the left side of the Migration Tool 
screen, the details for the selected user display, showing the following information:

■ Source User displays domain_name/batch_number/user_name

■ Domain to which the user belongs

■ Batch to which the user belongs

■ Status (Pending, Migrating, Done, Premigration Done, Premigration Failed, or 
Failed)

■ Number of folders

■ Migration start time

■ Migration end time

■ At the bottom of the page the User Migration Progress is displayed as a 
progress bar that also shows the number of folders migrated and the amount of 
total bytes written

Note: If one folder fails to migrate, the user is marked as Failed 
and must be migrated again.
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User States During Migration
A user is assigned one of the states shown in Table 2–2 during the data migration 
process.

Tuning for Performance
Read and write speeds are displayed at the bottom of the main Migration Tool 
screen, indicating the performance of the Migration Tool.

You can increase or decrease the number of users migrating concurrently to 
optimize performance.

If you have two batches scheduled to migrate at times that overlap each other, the 
migration speed does not increase.

Viewing Log Files
Log files are generated in the log directory of the Migration Tool. Every run of the 
Migration Tool generates a new log file that an administrator can open in any text 
editor to view the contents. Log files should be viewed frequently throughout the 
migration process.

Table 2–2 Migration States

State Description

Pending The user is yet to migrate

Migrating The user is currently migrating

Premigration Done The user was successfully premigrated and is ready for proper 
migration

Premigration Failed Premigration of the user failed but the user can still be picked 
up for proper migration

Done The user was successfully migrated

Failed Migration of the user failed, possibly due to failure of routing 
or mail migration

Failed users do not receive completion notifications

See Also: "Displaying User, Domain, Batch, and Migration Status 
Information" on page 2-17 for information about viewing user 
states in the Migration Tool screen
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The logs should be viewed after each of the following tasks to ensure successful 
migration:

■ Extraction of accounts, shared folders, public aliases, and distribution lists

■ Extraction of an MBOX file

■ Migration of data, accounts, shared folders, public aliases, and distribution lists

■ Routing a user

Note: When you perform an MBOX-based migration, MBOX files 
are generated by the plug-in. View the process_number.log file 
in the Migration Tool ORACLE_HOME/oes/migration/log
/process_number directory to view errors about extraction of 
MBOX, distribution list, public alias, user list, and shared folder 
files.

The process_number is unique for each run of the Migration 
Tool.

Note: Any extraction failures of the Migration Tool are logged in 
the ORACLE_HOME/oes/migration/log/migration
/process_number/text.log file.

The process_number is unique for each run of the Migration 
Tool.
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3
Migration Tasks

This chapter provides information about migration tasks.

This chapter contains these topics:

■ Administrator Responsibilities Before Migration

■ Task 1: Starting the Migration Tool

■ Task 2: Logging In to the Migration Repository

■ Task 3: Setting Up a Migration Session

■ Task 4: Migrating Users to Oracle Email

■ Task 5: Extracting Mail System Objects from the Source System

■ Task 6: Migrating Shared Folders

■ Task 7: Migrating Public Aliases

■ Task 8: Migrating Distribution Lists

■ Task 9: Migrating WebMail Address Books

■ Task 10: Migrating Data

■ Modifying Migration Parameters

■ Post-Migration Administrator Responsibilities
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Administrator Responsibilities Before Migration

This section contains the following topics:

■ Configuring the Domain Name Server Entry

■ IMAP Server Configuration

■ Verifying Source and Target IMAP Server Ports

■ Installing the Migration Tool

Configuring the Domain Name Server Entry
You must configure the DNS entry prior to beginning the migration process so that 
the target Oracle Email server is visible to the rest of the internet.

IMAP Server Configuration
The source IMAP servers should be suitably configured for a potentially large 
number of IMAP connections for concurrently migrating users. This includes 
database configuration for the source and target systems, if required.

The IMAP connection requirements are one connection for each concurrent user on 
the source IMAP server and three connections for each concurrent user on the target 
IMAP server.

To deploy message sharing in JMA-based migrations, you must configure the IMAP 
server as follows:

1. Use the Oracle Enterprise Manager administrator pages to add the value 
MigrationHeader=Message-ID to the Process Flag IMAP server process 
parameter.

2. Restart the IMAP server prior to running the Migration Tool.

Verifying Source and Target IMAP Server Ports
If you are performing an IMAP-based migration, verify that both the source and 
target IMAP servers are configured on port 143.

Note: At least one instance of Oracle Collaboration Suite, with the 
Oracle Email component, and Oracle Internet Directory must be 
installed on the target system prior to installing the Migration Tool.
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If you are performing an MBOX-based migration, verify that the target IMAP server 
only is configured on port 143.

Installing the Migration Tool
The Migration Tool can be run on both Windows NT and UNIX platforms.

To install the Migration Tool:

1. Unzip the esmigration.zip file located on the Oracle Collaboration Suite 
Clients CD-ROM.

For UNIX operating systems, navigate to the ORACLE_HOME/oes
/migration directory and enter the following:

unzip esmigration.zip

Note: If a port other than 143 is being used, you must configure 
the esmigration.config file.

See Also:

■ "Advanced Migration Tool Configuration" on page 3-16 for 
information about configuring ports

■ Oracle Email Administrator’s Guide for target IMAP server 
configuration information

Notes:

■ Some of the plug-ins will only run on one platform. Therefore, 
variables, such as the chosen migration path, will determine 
which platform you should use.

■ All source servers in the currently migrating site must stay up 
for the entire duration of the migration.

■ If you are migrating from a Microsoft Exchange source e-mail 
system and running the Migration Tool on a system other than 
the one upon which Microsoft Exchange is installed, ensure 
that Microsoft Outlook and Microsoft Exchange Administrator 
are installed on the system from which you are running the 
Migration Tool.
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For Windows NT operating systems, use WinZip to unzip and extract all files 
from the esmigration.zip file located in the ORACLE_HOME\oes
\migration directory.

For either operating system, the following files and directories are created 
where you unzip the esmigration.zip file: doc, help, log, files, bin, 
images, sql, config, lib, and mesg.

2. Set up the JREHOME environment variable to point to the Java Runtime 
Environment (JRE) 1.3.1 (or higher) directory.

Set up the variable either in the environment, or in the migrate.cmd 
(Windows) or migrate.sh (UNIX) files.

To set up JREHOME on UNIX operating systems, do the following:

■ For C-Shell, enter the following:

setenv JREHOME directory_containing_JDK

■ For Korn-Shell, enter the following:

set JREHOME=/directory_containing_JDK
export JREHOME

To set up JREHOME on Windows NT operating systems, use a MS-DOS prompt to 
enter the following command:

set JREHOME=C:\directory_containing_JDK

Once the Migration Tool is installed, you must choose and set up the appropriate 
plug-in for your source e-mail system.

Task 1: Starting the Migration Tool
To start the Migration Tool on UNIX operating systems, run the migrate.sh 
script, located in the Migration Tool bin directory, by entering the following 
commands:

cd bin
./migrate.sh

To start the Migration Tool on Windows NT operating systems, double-click the 
migrate.cmd file, located in the Migration Tool bin directory, or enter the 
following commands:
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C:\> cd bin
C:\> .\migrate.cmd

The Migration Repository Login screen displays, shown in Figure 3–1.

Multiple instances of the Migration Tool can be started if a situation warrants the 
use of multiple instances, as is the case in the following situations:

■ You can use multiple instances of the Migration Tool to migrate more users 
concurrently to a single mailstore

■ You can use multiple instances of the Migration Tool to connect to many 
mailstores in a multi-mailstore setup

Task 2: Logging In to the Migration Repository
The Migration Tool creates a repository under the es_mail user schema on the 
Oracle Email database. If a repository already exists, the Migration Tool reuses it.

Note: If you are migrating from a Lotus Notes source system, edit 
the migrate.cmd file to include the directory in which Lotus 
Notes is installed in the path, or set the path using a Windows DOS 
prompt, as follows:

set PATH=directory_where_Lotus_Notes_is_installed;%PATH%

Notes:

■ Multiple instances of the Migration Tool running against the 
same repository must be run from different systems.

■ When more than one Migration Tool instance runs against a 
single repository, each instance picks up users independently.
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Figure 3–1 Migration Repository Screen

1. Specify the following information to log in to the migration repository:

■ Password: The default password for the es_mail user is es.

■ Host: Enter the host name of the system on which Oracle Collaboration 
Suite is installed.

■ Port: The default port number on which the Oracle Net Services listener is 
running is 1521. Enter a different port number, if required.

■ SID: Enter the SID where Oracle Collaboration Suite is installed.

2. Click OK. If this is the first time you are connecting to the migration repository, 
the Migration Tool prompts you to create a new instance.

3. Click OK to display the Migration Setup Wizard Welcome screen.

Note: The Username field cannot be edited.

Note: If you enter a host name that is not exactly the same as the 
X.121HostName attribute of the target mail store, the Migration 
Setup Wizard fails at the Mail Services screen and you will have to 
exit the Migration Tool and log in again.
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Task 3: Setting Up a Migration Session
The Migration Setup Wizard collects details about the source and target domains; 
information for setting specific migration options; and notification of successful 
migration.

The following Migration Setup Wizard steps are described in this section:

■ Step 1: Specifying Mail System Objects

■ Step 2: Configuring Source Plug-ins

■ Step 3: Specifying Account Migration Options

■ Step 4: Specifying Mail Migration Options

■ Step 5: Specifying Migration Notifications

■ Step 6: Specifying Source LDAP Server Parameters

■ Step 7: Specifying Oracle Internet Directory Server Parameters

■ Step 8: Specifying LDAP Schema Mapping

■ Step 9: Specifying Mail Services

■ Step 10: Specifying New Account User Names

■ Modifying Migration Parameters

Click Next to display the Mail System Objects screen, shown in Figure 3–2.

Note: All of the following steps are not required. The number of 
required steps is determined by choices made in "Step 1: Specifying 
Mail System Objects".
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Step 1: Specifying Mail System Objects

Figure 3–2 Mail System Objects Screen

Specify the following information in the Mail System Objects screen:

■ Select the source e-mail system from the Source Mail System drop-down list

■ Select each of the objects you want to migrate. Do not select an object if:

– It does not exist on the source e-mail server

– You do not want to migrate the object

After you finish entering the information, click Next to display the Source System 
Information screen specific to the selection you made from the Source Mail System 
drop-down list.

See Also: Table 2–1, "Source E-mail System and Migration Tasks 
Supported" on page 2-11 for a list of source e-mail system choices
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Step 2: Configuring Source Plug-ins
This section contains information for configuring the various source e-mail system 
plug-ins.

This section contains the following topics:

■ Configuring the Oracle eMail Server Plug-in

■ Configuring the Microsoft Exchange Plug-in

■ Configuring the Lotus Notes Plug-in

■ Configuring the Novell GroupWise Plug-in

■ Configuring the Samsung Contact Plug-in

■ Advanced Configuration

Configuring the Oracle eMail Server Plug-in
Enter the Oracle eMail Server system information in the Source System Information 
screen, shown in Figure 3–3.

See Also:

■ "Requirements Before Migration" on page 2-2 for source system 
prerequisites

■ Table 2–1, "Source E-mail System and Migration Tasks 
Supported" on page 2-11 for a list of migration tasks supported 
by each plug-in



Task 3: Setting Up a Migration Session

3-10 Oracle Email Migration Tool Guide

Figure 3–3 Source System Information Screen for Oracle eMail Server 5.2.x

Specify the following in the DCN Information section of the Source System 
Information screen:

■ Domain Name: Enter the domain for the domain configuration node (DCN) of 
the Oracle eMail Server

■ Host: Enter the host name of the Oracle eMail Server DCN

■ Port: Enter the port of the Oracle eMail Server DCN

■ SID: Enter the SID of the Oracle eMail Server DCN

■ Password: Enter the oo account password for the DCN

Specify the following in the Node Information section of the Source System 
Information screen:

■ Node Name: Enter the name of the node on which Oracle eMail Server is 
running

■ Host: Enter the name of the node host

■ Port: Enter the port number on which the node listens

■ SID: Enter the SID of the node
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■ Password: Enter the password for the node

Click Next to display the Account Migration Options screen, shown in Figure 3–8.

Configuring the Microsoft Exchange Plug-in
Enter the Microsoft Exchange system information in the Source System Information 
screen, shown in Figure 3–4.

Figure 3–4 Source System Information Screen for Microsoft Exchange

■ Administrator Profile Name: Enter the name of the administrator profile you 
created

■ Administrator Profile Password: Enter the password of the administrator 
profile you created

■ Directory Host: Enter the host name of the machine on which the Microsoft 
Exchange directory is running

See Also: "Creating an Administrator Profile" on page 2-3
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Click Next to display the Account Migration Options screen, shown in Figure 3–8.

Configuring the Lotus Notes Plug-in
Enter the Lotus Notes system information in the Source System Information screen, 
shown in Figure 3–5

Figure 3–5 Source System Information Screen for Lotus Notes

■ Directory Host: Enter the host name of the machine on which the Lotus Notes 
directory is running

■ Password: Enter the password of the Lotus Notes administrator’s key file 
(user.id)

To further configure the Lotus Notes plug-in, do the following:

1. Move nesmtld.dll from the ORACLE_HOME/oes/migration/bin directory 
into the directory where Lotus Notes is installed.

See Also: "Microsoft Exchange" on page 3-18 for configuration 
instructions using the command line
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2. The key file (user.id) of the administrator (who also has permission to access 
and read all user’s mail files) must be available in the Data directory of the 
Lotus Notes installation.

3. The KeyFileName entry in the notes.ini file (located in the directory where 
Lotus Notes is installed) must contain the file name of the administrator’s key 
file.

4. Edit the notes.ini file in the directory where Lotus Notes is installed and add 
the following line to the end of the file:

EXTMGR_ADDINS=ESMTLD

Click Next to display the Account Migration Options screen, shown in Figure 3–8.

Configuring the Novell GroupWise Plug-in
Enter the Novell GroupWise system information in the Source System Information 
screen, shown in Figure 3–6.

Note: nesmtld.dll must be available only in the Lotus Notes 
directory and must not be present in any other directory on the 
machine where the plug-in is run.

See Also: "Lotus Notes" on page 3-18 for configuration 
instructions using the command line
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Figure 3–6 Source System Information Screen for Novell GroupWise

■ Administrator Profile Name: Enter the name of the administrator profile

■ Port: Enter the TCP/IP port of the GroupWise installation

■ Administrator Profile Password: Enter the password of the administrator 
profile

■ Directory Host: Enter the name of the host on which the GroupWise server is 
running

■ Administrator Name: Enter the name of the Novell eDirectory administrator

■ Administrator Password: Enter the password of the Novell eDirectory 
administrator

■ Tree Context: Enter the GroupWise eDirectory tree context

■ Tree Name: Name of the Novell eDirectory tree

■ UNC Path: Path to the shared location of wpdomain.db on the GroupWise 
server

See Also: "Novell GroupWise" on page 3-18 for configuration 
instructions using the command line
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Click Next to display the Account Migration Options screen, shown in Figure 3–8.

Configuring the Samsung Contact Plug-in
Enter the Samsung Contact system information in Source System Information 
screen, shown in Figure 3–7.

Figure 3–7 Source System Information Screen for Samsung Contact

■ Server Host: Enter the host name of the machine on which the Samsung 
Contact server resides

■ Administrator Name: Enter the name of the administrator of the Samsung 
Contact server

■ Administrator Password: Enter the password of the administrator of the 
Samsung Contact server

■ Internet Node for Internet Mails: Enter the name of the node configured for 
the Internet Mail Gateway

■ Temporary Directory on the Server: Enter the path to a temporary directory on 
the Samsung Contact server with read and write privileges
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Click Next to display the Account Migration Options screen, shown in Figure 3–8.

Advanced Configuration
This section describes further configuring the Migration Tool to improve 
performance, in addition to information for anyone who wants to run a plug-in 
from the command line.

This section contains the following topics:

■ Advanced Migration Tool Configuration

■ Configuring Plug-ins Using the Command Line

Advanced Migration Tool Configuration  By editing parameters located in the 
esmigration.config file in the ORACLE_HOME/oes/migration/config 
directory, you can do the following:

■ Specify the minimum and maximum number of connections in a pool created 
by each instance of the Migration Tool

■ Specify a particular instance of the Migration Tool by name

■ Specify the source IMAP server port (if different from 143)

■ Specify the number of concurrent users to migrate

Following are instructions for configuring Migration Tool parameters:

■ Every instance of the Migration Tool creates a pool of connections to the 
database. You can specify the minimum and maximum numbers of connections 
by editing the following parameters:

oracle.mail.migration.util.dbcache.min=1
oracle.mail.migration.util.dbcache.max=2

The values shown are default values.

See Also: "Samsung Contact" on page 3-19 for configuration 
instructions using the command line

Note: Advanced configuration should be done by advaced users, 
only. Under normal circumstances the esmigration.config file 
does not need editing.
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■ By default, the Migration Tool makes IMAP connections through port 143. If 
either the source or target IMAP server is set to a port other than 143, you can 
change it by editing the following parameters:

mail.imap.port.source=port_number
mail.imap.port.target=port_number

■ You can specify the number of users migrating concurrently by editing the 
following line:

oracle.mail.migration.migrate.num_of_threads=number_of_users

Once the parameters are configured, you can start the Migration Tool by entering 
the following command:

migrate.sh (on UNIX)

or

C:\migration\bin\> migrate (on Windows NT)

The Migration Repository screen displays, shown in Figure 3–1.

Configuring Plug-ins Using the Command Line  This section contains command line 
instructions for configuring the following plug-ins:

■ Microsoft Exchange

■ Lotus Notes

■ Novell GroupWise

Notes:

■ Oracle Corporation recommends setting the maximum value to 
N, where N is the number of users migrating concurrently.

■ If extra connections are needed after the maximum limit is 
reached, the Migration Tool still opens connections to the 
database. The extra connections immediately close when they 
are no longer required.

See Also: "Reconfiguring Heap Size" on page 2-12 to ensure that 
you have a large enough heap to accomodate the number of users 
you specify
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■ Samsung Contact

Microsoft Exchange
Edit the following parameters in the esmigration.config file:

oracle.mail.migration.plugin.msex.profile_admin=name_of_profile_with_
adminstrator_privileges

oracle.mail.migration.plugin.msex.profile_password=password_of_profile_with_
adminstrator_privileges

oracle.mail.migration.plugin.msex.directory_host=name_of_host_where_Microsoft_
Exchange_Directory_is_running

Lotus Notes
Edit the following parameters in the esmigration.config file:

oracle.mail.migration.plugin.lotus.directory_host=host_name_where_Lotus_Domino_
directory_server_is_running

oracle.mail.migration.plugin.lotus.userid_password=password_of_administrator’s_
key_file

Novell GroupWise
Edit the following parameters in the esmigration.config file:

oracle.mail.migration.plugin.grpwise.profile_admin=GroupWise_administrator
oracle.mail.migration.plugin.grpwise.port=server_port_on_which_GroupWise_poa_is_
running
oracle.mail.migration.plugin.grpwise.profile_password=GroupWise_administratror_
password
oracle.mail.migration.plugin.grpwise.directory_host=hostname_where_GroupWise_
server_is_running
oracle.mail.migration.plugin.grpwise.nds_admin=Novell_eDirectory_admin_name
oracle.mail.migration.plugin.grpwise.nds_tree=Novell_eDirectory_tree_name
oracle.mail.migration.plugin.grpwise.nds_password=Novell_eDirectory_admin_
password
oracle.mail.migration.plugin.grpwise.nds_uncpath=shared_location_of_wpdomain.db_
on_GroupWise_server
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Samsung Contact
Edit the following parameters in the esmigration.config file:

oracle.mail.migration.plugin.samsung.server_host=hostname_where_Samsung_Contact_
server_is_running
oracle.mail.migration.plugin.samsung.admin_name=name_of_user_with_admin_
privileges

oracle.mail.migration.plugin.samsung.admin_password=password_of_admin_user
oracle.mail.migration.plugin.samsung.inet_node=name_of_mail_node_used_for_
configuring_the_Internet_Mail_Gateway_using_omconfux_command

oracle.mail.migration.plugin.samsung.temp_dir=name_of_a_directory_on_Samsung_
Contact_server_system

Note: The uniform naming convention (UNC) path points to the 
location of wpdomain.db on the GroupWise server that holds the 
data of the GroupWise system. Use the directory structure where 
wpdomain.db resides. If this file resides on the same system on 
which the plug-in is run, there is no need to share the directory. If it 
resides on a remote system, the directory in which the file exists 
must be shared (preferably through drive mapping).

See Also: Novell GroupWise documentation for instructions 
regarding how to start the GroupWise server

Note: The admin_name must be in the OR (Originator Recipient) 
Name format with Personal Name and Organizational Units, as 
follows: John Smith/newyork,sales,collab,imteam

Note: For example, if you enter omconfux -m unix,mime, the 
inet_node entry is unix,mime.

Note: The temp directory must have read and write privileges 
because the plug-in uses it to write and read temporary files.
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Step 3: Specifying Account Migration Options

Figure 3–8 Account Migration Options Screen

Specify the following information in the Account Migration Options screen:

■ Migrate Base Accounts: Select to create public user accounts before enabling 
e-mail for the account

■ In the Information Source section, choose as your information source either 
LDAP Server or User Profiles File

■ Specify User Quota (in MB) by entering a number in the adjacent field, or by 
using the arrows to select a number

When you finish entering the information, click Next to display the Mail Migration 
Options screen, shown in Figure 3–9.

Note: If Oracle Collaboration Suite is already installed with Oracle 
Files configured and populated with users, deselect Migrate Base 
Accounts.
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Step 4: Specifying Mail Migration Options

Figure 3–9 Mail Migration Options Screen

Specify the following information in the Mail Migration Options screen:

■ In the Mail Migration section, select whether you want to perform an 
IMAP-based or MBOX-based migration

– IMAP-based: If your source e-mail system supports IMAP, the Migration 
Tool extracts the message information from the source e-mail system and 
places it directly into the target e-mail system

– MBOX-based: If your source e-mail system does not support IMAP, as is 
the case with Microsoft Exchange 5.0, choose this option. Select Generate 
MBOX and use the Browse button to specify the MBOX Directory Path to 
where the MBOX files will be created.

Note: The Oracle eMail Server 5.2 plug-in packaged with this 
release of the Migration Tool does not generate MBOX files.
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Do not select Generate MBOX if you are running the Migration Tool again, 
after an initial run. The files will already exist and need not be generated 
again.

If you do not select Generate MBOX on an initial run of the Migration Tool, 
you must provide the MBOX files in the MBOX directory location to the 
plug-in using the command-line interface.

No extraction of files will occur if Generate MBOX is not selected.

The Generate MBOX feature is useful for extracting MBOX files from a 
source system, moving them to an intermediate store, and loading them 
into the target Oracle Email server.

– Select Enable Routing to enable routing of mail to the new user accounts

■ In the Shared Folder Migration section, enter the folder owner’s target e-mail 
address

Notes:

■ MBOX is a common file-based mailstore, an intermediate 
storage format, similar to UNIX mail. The Migration Tool 
imports the information into the target e-mail system from the 
intermediate store.

■ There must be sufficient space on the target disk to store all of 
the users’ e-mail being migrated.

See Also: "Viewing Log Files" on page 2-21 for information on 
viewing the logs associated with MBOX file generation

Notes: If your source e-mail system is Microsoft Exchange and 
you select Enable Routing, a rule is created on the Microsoft 
Exchange server during each user migration to forward a copy of 
all future messages to the target e-mail system.
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When you finish entering the information, click Next to display the Notification 
screen, shown in Figure 3–10.

Step 5: Specifying Migration Notifications

Figure 3–10 Notification Screen

Notifications are e-mail messages that inform users about migration events.

Select either New Account Details, Migration Report, or both.

Note: Public folders in Microsoft Exchange have no 
corresponding object in Oracle Collaboration Suite. Therefore, you 
must assign public folders an owner. Enter a valid user ID in the 
Shared Folder Owner Name field. Typically, you would enter the 
mail ID of the Oracle Email administrator.
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■ When New Account Details is selected, after the account for the user is created 
on the target e-mail server, an e-mail is sent to the user’s old e-mail account 
notifying the user of their new user name, password, and IMAP and SMTP host 
names.

■ When Migration Report is selected, you can choose include a verification 
report when you send a notification to either the user’s target account, the 
administrator, or both, notifying them that the migration is complete and that 
the user can begin using the new account.

If you choose to send a migration report to the administrator, enter the 
administrator’s user ID on Oracle Collaboration Suite in the Administrator 
Email Address field.

Click Customize Notification to add header and footer notes to the notification.

When you finish entering the information, click Next to display the Source LDAP 
Service screen, shown in Figure 3–11.

Note: If you choose to run a two-phase migration, do not select 
either New Account Details or Migration Report. Click Next to 
proceed to "Step 6: Specifying Source LDAP Server Parameters".

See Also: "Performing a Two-Phase Migration" on page 3-43 for 
more information about two-phase migration

Note: Select only New Account Details when you are using the 
Migration Tool to create accounts but not migrating any data.

Note: Select only Migration Report if you are not creating 
accounts with the Migration Tool.
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Step 6: Specifying Source LDAP Server Parameters 

Figure 3–11 Source LDAP Service Screen

Specify the following source LDAP server information in the Source LDAP Service  
screen:

■ Host: Enter the host name of the machine on which the source directory server 
is running

■ Port: Enter the port number on which the source directory server is listening

The default port number for LDAP is 389. Update the port number if your port 
number is different.

■ Administrator DN: Enter the directory manager distinguished name

Note: If you are migrating from Microsoft Exchange, Active 
Directory may be running on port 389, in which case you must use 
the Microsoft Exchange Administrator to bind the LDAP protocol 
to another port, such as 390.
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■ Administrator Password: Enter the directory manager password

Leave the Administrator DN and the Administrator Password fields empty if 
the source LDAP server supports anonymous login.

■ Object Class of E-mail User: Enter the object class that identifies the schema of 
an e-mail user on the source LDAP server

When you finish entering the information, click Next to display the Target LDAP 
Service screen, shown in Figure 3–12.

Step 7: Specifying Oracle Internet Directory Server Parameters

Figure 3–12 Target LDAP Service Screen

Specify the following target Oracle Internet Directory information in the Target 
LDAP Service screen:

See Also: Oracle Email Administrator’s Guide for more information 
about the e-mail user schema
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■ Host: Enter the host name of the machine on which the Oracle Internet 
Directory server is running

■ Port: Enter the port number on which the Oracle Internet Directory server is 
listening

The default port number for LDAP is 389. Update the port number if your port 
number is different.

■ Administrator DN: Enter the directory manager distinguished name

■ Administrator Password: Enter the directory manager password

When you finish entering the information, click Next to display the LDAP Schema 
Mapping screen shown in Figure 3–13.

Note: If you did not select Accounts in "Step 1: Specifying Mail 
System Objects", or you selected Accounts but did not select 
Migrate Base Accounts in "Step 3: Specifying Account Migration 
Options", the Username Generation screen, shown in Figure 3–15, 
displays after you click Next. The Username Generation screen also 
displays if you selected Migrate Base Accounts and User Profiles 
File in "Step 3: Specifying Account Migration Options".
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Step 8: Specifying LDAP Schema Mapping

Figure 3–13 LDAP Schema Mapping Screen

On Oracle Email, an e-mail account is described by the orclperson object class. 
The object class attributes cn (common name) and sn (last name) must map to 
source directory attributes.

Mandatory Attributes: Click the source attribute on the right to display a 
drop-down list of mapping choices and select the mapping that you want to update 
the source attribute.

Non-Mandatory Attributes: Attributes that are not mandatory on the target Oracle 
Internet Directory have the option No Mapping displayed in the right column. 
Click the attribute to display a drop-down list of attribute choices to which to map if 
you want to map a non-mandatory attribute.

Note: You need only map these attributes once, because the 
Migration Tool saves the values for the subsequent batches.
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When you finish entering the information, click Next to display the Mail Services 
screen, shown in Figure 3–14.

Step 9: Specifying Mail Services

Figure 3–14 Mail Services Screen

Specify the following source and target mail system information in the Mail 
Services screen:

■ Choose the distinguished name (DN) of the target mail store from the Mail 
Store drop-down list, 

■ In the Mail Systems section, enter the following:

– Source Domain: Enter the source e-mail domain name

Note: Depending on your selections in the previous steps, the 
following text boxes are enabled on an as-needed basis.
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– Target Domain: Enter the target e-mail domain name to which the source 
domain maps

The data that belongs to a source domain is created on the target domain to 
which this source domain is mapped. For example, all objects belonging to 
both us.oracle.com and uk.oracle.com are created under 
oracle.com.

– Source IMAP Host: Enter the source IMAP host name (if you selected the 
MBOX based migration option in the previous step, this field does not 
appear)

– Target IMAP Host: Enter the target IMAP host name

– Source LDAP DN: Enter the LDAP DN for users on the source domain. If 
you have more than one domain, enter the LDAP DNs for all the domains. 
The Migration Tool looks for source account entries under the DN of the 
LDAP. Each domain has a separate DN.

– Target LDAP DN: Enter the LDAP DN as the DN of the Base Subscriber 
tree for Oracle Collaboration Suite users in Oracle Internet Directory.

For example, if the DNS domain of your server is us.oracle.com, the 
typical format is  cn=Users,dc=us,dc=oracle,dc=com. This domain 
must correspond exactly to the configuration of your Oracle Collaboration 
Suite installation.

The Migration Tool creates base account entries under the DN of the LDAP 
entry. Each domain has a separate DN.

– Target SMTP Host: Enter the SMTP host of the target domain that listens 
for e-mail

When you finish entering the information, click Next to display the User Name 
Generation screen, shown in Figure 3–15.

See Also: Your LDAP server documentation for information 
about DN representation

Note: The Target SMTP Host field will only be active when you 
choose to send out migration notifications or have the Migration 
Tool create routing rules.
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Step 10: Specifying New Account User Names

Figure 3–15 User Name Generation Screen

To generate new account user names, select one of the following:

■ Retain Old Usernames: Specifies that the target user names remain the same as 
the source user names

■ Construct New Usernames: Specifies that the Migration Tool generates the 
target user names

If you choose to have the Migration Tool construct new user names, you must 
also supply the rules for user name generation in the Construct New 
Usernames section.

When supplying rules for new user name construction, you can choose to retain 
the first, middle, or last names, or any combination of the three. Select the 
appropriate box to retain any of the three names.

You can also retain only part of a name by choosing the number of characters 
you want to retain. Specify the number of characters you want to use in the 
Characters field adjacent to each name.
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You must also choose a separator character. To select a separator character, click 
the Name Separator drop-down list.

When you finish entering the information, click Next. The Summary screen 
displays. Click Finish to quit the Migration Setup Wizard and display the Oracle 
Email Migration Tool screen.

Resolving Account Name Conflicts
If the Migration Tool detects any duplicate target user names (also called name 
conflicts) when creating accounts in the target Oracle Internet Directory, it logs an 
error and does not create the duplicate account.

Duplicate target user name errors (name conflict errors) can only be avoided if user 
name generation rules are chosen so that unique target user names are generated.

To resolve name conflicts, perform the following steps:

1. Manually create the user with a unique name in Oracle Email.

2. Choose Edit > User Details to edit the information for that user.

3. Update the user’s status to Migrate User Data.

When all accounts have been successfully created, proceed to creating batches and 
migrating user data.

Notes:

■ If a name is disabled, it was not mapped in the LDAP Schema 
Mapping screen.

■ The values for first name, middle name, and last name are 
picked up from the source LDAP attributes that map to the 
given name, middle name, and surname orclperson 
attributes. You must provide this mapping in the LDAP 
Attribute Mapping screen.

■ Target user names, if specified in the user list, are used in all 
cases.

See Also:

■ "Creating Batches" on page 3-40

■ "Task 10: Migrating Data" on page 3-40
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Task 4: Migrating Users to Oracle Email
To migrate account information from the source directory server to Oracle Email, do 
the following:

1. Choose Extract > Users from the Migration Tool menu bar to generate 
users.xml.

2. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
account migration are logged in the text.log file as administrator error 
messages.

3. Choose File > Load Users from the Migration Tool menu bar to load 
users.xml into the repository.

4. If you selected Accounts in "Step 1: Specifying Mail System Objects", choose 
Migrate > Create Users on Oracle from the Migration Tool menu bar to create 
user accounts in the target Oracle Internet Directory.

5. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
account migration are logged in the text.log file as administrator error 
messages.

If account migration for a specific user fails, you can modify the user’s details and 
attempt to re-migrate the batch after editing.

Note: If you selected User Profiles File from the Account 
Migration Options screen, choose Extract > User Profiles to 
generate the user_profiles.ldif file.

See Also:

■ "Overview of the Oracle Email Migration Tool Screen" on 
page 2-14 for information about the location of the users.xml 
file

■ Appendix A, "Plug-In Generated File Formats" for more 
information about user profile file formats

See Also: Oracle Email Administrator’s Guide for descriptions of 
error messages
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To modify user details, do the following:

1. Choose Edit > User Details from the Migration Tool menu bar. The Edit Users 
screen displays, shown in Figure 3–17.

Figure 3–16 Edit Users Screen

2. Enter a source user name in the Find field and click Search to display all users 
in the repository matching the search criteria.

Use % as a wildcard to assist in your search.

3. Select the row containing the user you want to edit from the displayed list and 
click OK. The left hand pane of the Migration Tool screen expands with that 
user selected.

4. Click User Details on the Migration Tool screen to display the Modify User 
Details screen shown in Figure 3–17.

Note: You can also select a user from the directory tree, choose 
Edit > User Details, and proceed with modifying the user’s details.
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Figure 3–17 Modify User Details Screen

5. Edit the field entries.

6. Update the migration status by choosing from the list of choices in the Status 
drop-down list.

7. Click OK.

Task 5: Extracting Mail System Objects from the Source System
1. If you chose to migrate shared folders, choose Extract > Shared Folders from 

the Migration Tool menu bar to generate the shared_folders.ldif file in 
the files directory.

Note: Fields are populated according to what is stored in the 
migration repository during the preceding steps. Changes made on 
this screen are reflected back to the repository.
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2. If you chose to migrate public aliases, choose Extract > Public Aliases from the 
Migration Tool menu bar to generate the public_aliases.ldif file in the 
files directory.

3. If you chose to migrate distribution lists, choose Extract > Distribution Lists 
from the Migration Tool menu bar to generate the 
distribution_lists.ldif file in the files directory.

4. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during mail 
system object extraction are logged in the text.log file as administrator error 
messages.

Task 6: Migrating Shared Folders
Prior to migrating shared folders, ensure that the following tasks are complete:

■ All user accounts have been migrated

■ You have generated the shared folders file

To migrate shared folders, do the following:

1. Choose Migrate > Migrate Shared Folders from the Migration Tool menu bar 
to create the shared folders on the target e-mail server. The Shared Folder 
Migration Status screen displays.

2. When 100% displays, indicating the migration is complete, click OK.

3. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
shared folder migration are logged in the text.log file as administrator error 
messages.

To cancel migration of shared folders, click Cancel on the status dialog that displays 
when you start to migrate mail objects.

See Also: "Task 5: Extracting Mail System Objects from the Source 
System" on page 3-35 to generate the shared folder file

See Also: Oracle Email Administrator’s Guide for descriptions of 
error messages
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Task 7: Migrating Public Aliases
Prior to migrating public aliases, ensure that the following tasks are complete:

■ All user accounts have been migrated

■ You have generated the public aliases file

To migrate public aliases, do the following:

1. Choose Migrate > Migrate Public Aliases from the Migration Tool menu bar to 
create the public aliases on the target e-mail server. The Public Alias Migration 
Status screen displays.

2. When 100% displays, indicating the migration is complete, click OK.

3. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
public aliases migration are logged in the text.log file as administrator error 
messages.

To cancel migration of public aliases, click Cancel on the status dialog that displays 
when you start to migrate mail objects.

Note: If you cancel migration of shared folders, rollback does not 
occur and you can safely restart migration. The e-mail objects that 
were created before you canceled migration are not re-created when 
migration is recommenced. Migration continues from the point 
where it was canceled.

See Also: "Task 5: Extracting Mail System Objects from the Source 
System" on page 3-35 to generate the public aliases file

See Also: Oracle Email Administrator’s Guide for descriptions of 
error messages

Note: If you cancel migration of public aliases, rollback does not 
occur and you can safely restart migration. The e-mail objects that 
were created before you canceled migration are not re-created when 
migration is recommenced. Migration continues from the point 
where it was canceled.
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Task 8: Migrating Distribution Lists
Prior to migrating distribution lists, ensure that the following tasks are complete:

■ All user accounts have been migrated

■ You have generated the distribution lists file

There are two phases to distribution list migration:

■ All distribution lists are created

■ The distribution lists are populated with users

The status bar displays immediately, and shows progress when distribution lists are 
being populated with users. For example, when the status bar shows that 50% of the 
distribution lists have been migrated, it means all of the distribution lists have been 
created and 50% of the distribution lists have been populated with users.

To migrate distribution lists, do the following:

1. Choose Migrate > Migrate Distribution Lists from the Migration Tool menu 
bar to create the distribution lists on the target e-mail server. The Distribution 
List Migration Status screen displays.

2. When 100% displays, indicating the migration is complete, click OK.

3. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
distribution list migration are logged in the text.log file as administrator 
error messages.

To cancel migration of distribution lists, click Cancel on the status dialog that 
displays when you start to migrate mail objects.

See Also: "Task 5: Extracting Mail System Objects from the Source 
System" on page 3-35 to generate the distribution lists file

See Also: Oracle Email Administrator’s Guide for descriptions of 
error messages
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Task 9: Migrating WebMail Address Books

The Migration Tool can migrate the private address books created by users using 
their Oracle eMail Server 5.2.1 WebMail client. Migration of the WebMail address 
book of each user involves migrating both the private aliases and private 
distribution lists that users have.

Prior to migrating address books, ensure that all user accounts have been migrated.

To migrate WebMail address books, do the following:

1. Choose Migrate > Migrate Address Book from the Migration Tool menu bar. 
The Address Book Migration Status screen displays.

2. When 100% displays, indicating the migration is complete, click OK.

3. View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during 
address book migration are logged in the text.log file as administrator error 
messages.

To cancel migration of address books, click Cancel on the status dialog that displays 
when you start to migrate address books.

Note: If you cancel migration of distribution lists, rollback does 
not occur and you can safely restart migration. The e-mail objects 
that were created before you canceled migration will not be 
re-created when migration is recommenced. Migration continues 
from the point where it was canceled.

Note: WebMail Address Book migration is available only for 
Oracle eMail Server to Oracle Email migrations. This migration can 
only be run for users using the Oracle eMail Server 5.2.1 WebMail 
client.

See Also: Oracle Email Administrator’s Guide for descriptions of 
error messages
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Task 10: Migrating Data
This section contains the following topics:

■ Creating Batches

■ Scheduling Batches and Migrating User E-mails

■ Performing a Two-Phase Migration

Creating Batches
Prior to migrating data you must create and schedule batches for migration.

Using the Migration Tool, you can create a batch either by designating the number 
of users for each batch or by creating a custom batch.

Batch creation is done on a domain basis.

To create a batch by domain, do the following:

1. Expand the Migration Instance node on the directory tree on the left side of the 
Migration Tool screen.

2. Select the appropriate domain.

3. Choose File > Create Batch. The Create screen displays, as shown in 
Figure 3–18.

Note: If you cancel migration of address books, rollback does not 
occur and you can safely restart migration. The address book 
objects that were created before you canceled migration are not 
re-created when migration is recommenced. Migration continues 
from the point where it was canceled.
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Figure 3–18 Create Screen

4. Create batches using one of the following methods:

■ Select Full User List and enter or use the arrows to select the number of 
Users per Batch in the adjacent field. For example, if you have 100 users 
and specify 5 users in each batch, 20 batches are created.

■ Select Custom User List to create a custom batch.

Prepare a file containing the users formatted according to the following 
example:

<userlist>
<user sourceimapuserid="test1" targetimapuserid="Test2" />
</userlist>

Enter the path to the custom batch file in the adjacent field or use the 
Browse button to locate the file.

After you create the batches, you can view them by expanding the domain node on 
the Migration Tool screen to display all the batches in the domain.

Scheduling Batches and Migrating User E-mails
To schedule batches for user e-mail migration, expand the domain node to view the 
batches, as shown in Figure 2–4, "Migration Tool Screen with Batch Information 
Displayed".

See Also: "Task 10: Migrating Data" on page 3-40 for information 
about scheduling batches for migration



Task 10: Migrating Data

3-42 Oracle Email Migration Tool Guide

To schedule a start time for batch migration, do the following:

1. Select a batch from the directory tree in the Migration Tool screen.

2. Click Schedule to display the Schedule Start Time screen shown in Figure 3–19.

Figure 3–19 Schedule Start Time Screen

3. In the New Scheduled Start Time field, edit the day, date, and time by selecting 
one element in the string and using the Up and Down arrows to scroll through 
and select values.

4. Click OK.

To start data migration, choose Migrate > Migrate User Data from the Migration 
Tool menu bar.

Migration begins at the time you selected while scheduling batches. If you start 
migration at a time later than that which you scheduled, migration begins instantly.

To cancel migration, choose Migrate > Cancel Migration from the Migration Tool 
menu bar.

View the text.log file located in the ORACLE_HOME/oes/migration/log
/migration/process_number directory. Any errors that occur during data 
migration are logged in the text.log file.

Note: You can schedule multiple batches to migrate in parallel by 
scheduling them to start at the same time.
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Performing a Two-Phase Migration
Because the migration of user accounts and messages involves transferring large 
amounts of data and is, therefore, time consuming, users must be transferred from 
the old system to the new in the least possible amount of time.

The Migration Tool provides a two-phase migration option to achieve these 
conflicting goals that transfers messages from the old system to the new Oracle 
Email.

This section contains the following topics:

■ Phase I: Pre-Migration

■ Phase II: User Migration

Phase I: Pre-Migration
All users’ messages from the source system are written into the target Oracle Email 
system. User accounts, however, are not actually populated with messages, nor are 
their folders created. In this phase all the message bodies are transferred into the 
Oracle Email system. This is typically done in the background over several days 
while users continue to use their old accounts.

To start pre-migration, do the following:

1. Ensure that user accounts have been created on the target Oracle Email system.

2. Ensure that message routing has been disabled.

3. Choose Migrate > Pre-Migrate User Data from the Migration Tool menu bar.

Note: If a single user in a batch fails, the batch is marked as failed. 
To reschedule the batch for migration, select the failed batch from 
the Migration Tool screen, edit the Scheduled Start Time field, and 
click OK. Once a batch is rescheduled, the users that failed are 
reverted to the pending state and the batch is picked up again for 
data migration when the scheduled migration time occurs. Only 
users that have failed to migrate are migrated. Users that have been 
successfully migrated are not re-migrated.

See Also: "Step 3: Specifying Account Migration Options" on 
page 3-20 for more information about message routing
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Phase II: User Migration
In the second phase, the Migration Tool takes advantage of the message sharing 
capability of Oracle Email to quickly populate users’ folders with the messages that 
were transferred in the first phase.

This phase typically involves only minimal housekeeping updates to the e-mail 
store and folder creation, and can be done over a weekend. During the second 
phase, the following operations are performed:

■ Any new messages that users receive between the first and second phases are 
transferred to the target user account

■ Any messages that users delete in the interim do not appear in the target users’ 
accounts

■ Any new folders that users create in the interim are transferred to the target 
users’ account

■ Any folders that users have deleted in the interim do not appear in the target 
users’ account

Follow the procedures for migrating data in this section to perform the second 
phase of the migration.

Modifying Migration Parameters
Any changes you make take effect after you cancel and restart the migration.

You cannot modify migration parameters during the migration.

Notes:

■ For best results, the second phase should be performed as 
quickly as possible after the first phase is complete.

■ When you perform a two-phase migration, all batches are 
migrated during both phases. It is not possible to selectively 
migrate specific batches during a two-phase migration.

Note: If two or more instances of the Migration Tool are running 
against the same repository, all instances except one must be shut 
down before modifications to the migration parameters can 
proceed.
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To modify migration parameters, do the following:

1. Choose Edit > Migration Parameters from the Migration Tool menu bar. The 
Modify Migration Parameters screen displays, as shown in Figure 3–20.

Figure 3–20 Modify Migration Parameters Screen

2. Modify the parameters.

3. Click OK.

Note: Values for these parameters were originally entered in "Step 
4: Specifying Mail Migration Options", "Step 6: Specifying Source 
LDAP Server Parameters", and "Step 7: Specifying Oracle Internet 
Directory Server Parameters".
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Post-Migration Administrator Responsibilities
Upon completion of migration, the administrator must perform certain 
post-migration tasks.

This section contains the following topics:

■ Changing the MX Record

■ Verifying Migration

■ Viewing User Status

■ Shutting Down Source Mail Servers

Changing the MX Record
You must change the mail exchanger (MX) record in order to redirect e-mail to the 
new system.

Verifying Migration
You can verify the migration of individual users’ accounts and data using one of 
several methods of comparison. This helps the administrator to verify the validity 
of the overall migration, and is also helpful to support personnel when users 
complain of discrepancies in their accounts.

To access the Verification screen shown in Figure 3–21, choose Migrate > Verify 
New Accounts from the Migration Tool menu bar.

Note: Routing is not implemented for Novell GroupWise and you 
should immediately switch to using Oracle Collaboration Suite 
after the MX record changes.

Notes:

■ The verifier can only be used for users who have successfully 
migrated.

■ The verifier is not available for MBOX-based migration.
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Figure 3–21 Verification Screen

1. Enter the user IDs of users you want to verify in the Username field.

You can populate the Username field using the search feature. The search 
feature enables you to search for specific users.

a. Choose from the Category drop-down list either New User Name, Target 
Domain Name, or Batch No.

b. Choose from the Criteria drop-down list either Starts with, Ends with, or 
equals.
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c. Enter a user name, domain, or batch number in the Keyword field. Use % 
as a wildcard character for partial entries.

d. Click Search.

The results of your search display in the Username, Batch, and Domain 
fields. Select the users you want to verify or click Select All to select all of 
the users in the returned list.

2. Select from one of the following verification options:

■ Message Count: Compares the message counts in the folders to verify that 
they match

■ Message IDs: Compares the SMTP message IDs to verify that they match

■ Message Header: Compares the message headers to verify that they match

■ Entire Message: Compares the message bodies of every message to verify 
that they match

3. Enter the address of the recipient of the verification reports in the 
Administrator Email ID field. Any verification errors are shown in this report.

4. Click OK.

Viewing User Status
The Oracle Email Migration Tool enables you to view users according to their 
migration status. Click Migrate > User Status to display the View User Status 
screen, shown in Figure 3–22.

Note: Each option verifies that all folders in an individual user’s 
account have been created on the target e-mail system, and 
compares different message information between the source and 
target e-mail systems.

Note: If you choose either the Message Header or Entire Message 
verification option while migration is proceeding, migration 
process is slowed considerably.
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Figure 3–22 View User Status Screen

1. Select a domain from the Domain drop-down list.

2. Select a batch from the Batch list.

3. Select a particular status from the Status drop-down list.

4. Click Show Users to display a list of users whose status is that which you 
selected in the Results section.

5. Click Ok to exit the screen.

See Also: "User States During Migration" on page 2-21 for an 
explanation of the various user states
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Shutting Down Source Mail Servers
You can shut down the source mail server upon completion of migration only after 
you determine that you no longer need routing rules set up on the source e-mail 
system.

Note: If you have multiple Microsoft Exchange servers, you can 
move users from whichever machine they reside to one single 
machine as their data is migrated to Oracle Email.

See Also: Microsoft Exchange documentation for information 
about moving users from one machine to another



Plug-In Generated File Formats A-1

A
Plug-In Generated File Formats

This appendix provides the following sample LDIF and XML file formats:

■ User List File Format (XML)

■ Distribution List File Format (LDIF)

■ Public Aliases File Format (LDIF)

■ Shared Folder File Format (LDIF)

■ User Profile File Format (LDIF)

■ Rules File Format (XML)
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User List File Format (XML)
Following is the syntax of a user list file in XML format (users.xml):

?xml version="1.0" encoding="UTF-8" ?>
<!ELEMENT userlist (user*)>
<!ELEMENT user EMPTY>
<!ATTLIST user sourceimapuserid CDATA #REQUIRED sourceimappasswd CDATA #IMPLIED
             sourceimapserver CDATA #IMPLIED targetimapuserid CDATA #IMPLIED
               targetimappasswd CDATA #IMPLIED targetimapserver CDATA #IMPLIED
             targetdomain CDATA #IMPLIED mailstore CDATA #IMPLIED
               quota CDATA #IMPLIED>

For IMAP-based migration, the sourceimapuserid and sourceimappasswd 
attributes are mandatory. For MBOX-based migration, only the 
sourceimapuserid attribute is mandatory.

Following is a sample user list file for two users:

<userlist> 
<user 
sourceimapuserid="TEST1" 
sourceimappasswd="WELCOME" 
/> 
<user 
sourceimapuserid="TEST2" 
sourceimappasswd="WELCOME" 
/> 
</userlist>

The values for all other attributes are provided using the Migration Setup Wizard. 
For any user, if the administrator does not want to use the default values, specific 
values can be provided using the specified format.

Distribution List File Format (LDIF)
The distribution list file, distribution_lists.ldif, that the plug-in generates 
is in the following format:

dn: cn= dl1
cn:dl1
objectclass:  top
objectclass: groupofuniquenames
objectclass:  orclMailGroup
orclmgprfc822mailmember: user1@acme.com
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orclmgprfc822mailmember: user2@acme.com
mail:dl1@acme.com
uniquemember: dl200@acme.com
uniquemember: dl300@acme.com
uniquemember: dl400@acme.com

dn: cn= dl2
cn:dl2
objectclass:  top
objectclass: groupofuniquenames
objectclass:  orclMailGroup
orclmgprfc822mailmember: user4@acme.com
orclmgprfc822mailmember: user3@acme.com
mail:dl2@acme.com
uniquemember: xd1500@acme.com
uniquemember: xd1400@acme.com

The mail attribute contains the fully-qualified name of the distribution list. The 
Migration Tool expects the name in the format dlname@sourcedomain.

The orclmgprfc822mailmember attribute is the fully-qualified e-mail address of 
a user who is a member of the distribution list. The Migration Tool expects the name 
in the format source_imap_userid@sourcedomain.

The uniqumember attribute contains the sub distribution lists of this distribution 
list. The Migration Tool expects the name in the format dlname@sourcedomain.

Public Aliases File Format (LDIF)
The public alias information file, public_aliases.ldif, that the plug-in 
generates is in the following format:

dn:cn=alias1
name:alias1@acme.com
cn:alias1
orclmailemail:user1@acme.com
objectclass:top
objectclass:orclMailAlias

dn:cn=alias2
name:alias2@acme.com
cn:alias3@acme.com
orclmailemail:user2@acme.com
objectclass:top
objectclass:orclMailAlias
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dn:cn=alias3
name:alias3@acme.com
cn:alias3
orclmailemail:user3@acme.com
objectclass:top
objectclass:orclMailAlias

The name attribute contains the fully-qualified name of the alias. The Migration 
Tool expects the name in the format aliasname@sourcedomain.

The orclmailemail attribute is the fully-qualified e-mail address of the user for 
whom this alias is created. The Migration Tool expects the name in the format 
source_imap_userid@sourcedomain.

Shared Folder File Format (LDIF)
The shared folder file, shared_folders.ldif, generated by the plug-in contains 
information about shared folders that are being migrated, and is in the following 
format:

dn: cn=/pubfol
objectclass: top
objectclass: orclMailFolder
orclmailaci: user2@acme.com l r w
orclmailaci: user4@acme.com l r
owner: user1@acme.com
cn:/pubfol
orclIsSharedFolder: false

dn: cn=/shfol
objectclass: top
objectclass: orclMailFolder
orclmailaci: user2@acme.com l r w
orclmailaci: user4@acme.com l r
owner: user1@acme.com
cn:/shfol
orclIsSharedFolder: true

The cn attribute contains the name of the shared folder. The Migration Tool expects 
the name in the format /foldername.

The orclmailaci attribute contains ACI information. The Migration Tool expects 
the user name of the ACI in the format source_imap_userid@sourcedomain.
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The orclIsSharedFolder attribute has a false value if the folder is a public 
folder.

The orclMailStore attribute contains the distinguished name of the target mail 
store on which the shared folder is to be created.

The owner attribute contains the fully-qualified mail address of the owner of the 
shared folder. The Migration Tool expects the name in the format 
source_imap_userid@sourcedomain.

User Profile File Format (LDIF)
If your source directory information comes from a user profile file, 
user_profiles.ldif, instead of an LDAP directory, use the following format:

dn: cn=user_given_name,dc=acme,dc=com
cn: user_given_name
mail: username@acme.com
title:title
telephoneNumber:telephone_number
homePhone:telephone_number
sn:surname
st:state
physicalDeliveryOfficeName:physical_delivery_address_of_office
manager:user’s_manager
ou:organizational_unit
o:organization
secretary:name_of_secretary
postalAddress:postal_delivery_address

The only mandatory attributes are mail and sn and mail is expected in the format 
sourceuserid@sourcedomain.

Rules File Format (XML)
A rule consists of two parts: a set of conditions to be met, and actions to be 
performed when at least one of the set of conditions is met. The set of conditions is 
evaluated until a true condition in the set is encountered. Rules are identified by 
their actions. If multiple actions are to be carried out when a certain condition is 
true, then multiple rules must be defined sharing the same set of conditions.

A condition is a combination of simple clauses. A clause is a relational operation 
between a message attribute and a scalar constant value. For example, a clause can 
be "message size is greater than 10 Kb".
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Condition evaluation is implemented as a short-circuit AND operation upon all 
clauses, which fails upon encountering the first failed clause.

A rulelist is a list of rules that apply when a message is delivered to a user’s 
inbox. A rule begins with the tag <rule> and ends with the tag </rule>. A 
condition begins with the tag <condition>, as shown in the following example 
rule in XML format:

<account qualifiedName="user_rules" ownerType="user">
 <rulelist event ="deliver">
 <rule  visible= "yes" active= "yes" description = "exchusr1" >
   <condition>
    <attribute tag="rfc822from"/>
    <operator op="contains"/>
    <operand> EXCHUSR1 </operand>
   </condition>
  <action>
   <command  tag= "moveto"/>
   <parameter>/pvtfldr1 </parameter>
  </action>
 </rule>

 </rulelist>
</account>

Following is the XML format for specifying a server-side rule:

<?xml version="1.0" encoding="UTF-8" ?>
<!-- an account contains multiple rulelists -->
<!ELEMENT account (rulelist*)>
<!ATTLIST account name NMTOKEN #REQUIRED
                  ownerType (user|system|domain) "user">
<!-- a rulelist is associated with an event and a list of rules -->
<!ELEMENT rulelist (rule+)>
<!ATTLIST rulelist event (relay|reception|deliver|flagchange|move|copy|
  queuing|expunge|expire) #REQUIRED>
<!-- a rule consists of an optional condition and a list of actions.
     a rule can be visible, hidden, activated or disabled -->
<!ELEMENT rule (condition?, action+)>
<!ATTLIST rule visible (yes|no) "yes"
       active (yes|no) "yes"
       description CDATA #IMPLIED>
<!-- conditions are either attribute comparisons (leaf conditions),
     sub conditions (parenthesis) or external procedure calls -->
<!ELEMENT condition ((attribute, operator, operand*)
    |condition+|procCall|inBody)>
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<!ATTLIST condition negation (yes|no) "no">
<!ATTLIST condition junction (and|or) "and">
<!-- attributes are message properties, param is for extended header and flag-->
<!ELEMENT attribute EMPTY>
<!ATTLIST attribute name (rfc822from|rfc822to|rfc822cc|rfc822date|
                          rfc822subject|rfc822replyto|sendhost|sender|
                          recipients|message_id|receiveddate|
                          contenttype|charset|xpriority|messagesize|
                          xheader|folder|flag|overquota|rulestatus)
                          #REQUIRED
                    param CDATA #IMPLIED>
<!-- operators -->
<!ELEMENT operator EMPTY>
<!ATTLIST operator op (equal|greaterthan|lessthan|lessequal|
                       greaterequal|in|stringequal|isnull|
                       startswith|endswith|contains|between|istrue)
                       #REQUIRED
                   caseSensitive (yes|no) "no">
<!-- operands custom data -->
<!ELEMENT operand (#PCDATA)>
<!-- procCall is external condition call -->
<!ELEMENT procCall (#PCDATA)>
<!-- inBody is content related match condition -->
<!ELEMENT inBody (#PCDATA)>
<!-- actions may have parameters-->
<!ELEMENT action (command, parameter*)>
<!ELEMENT command EMPTY>
<!ATTLIST command name (pass|reject|suspend|discard|forward|
                        bcc|moveto|copyto|setprop|notify|reply|
                        replyall|break|sign|verify|decrypt|
      encrypt|enqueue|call) #REQUIRED>
<!ELEMENT parameter (#PCDATA)>
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B
API Architecture

This appendix contains information about the architecture of an API that 
communicates with a third party plug-in.

Any plug-in that is to work with the Migration Tool must support the following 
interface:

public interface PluginInterface
{
    public boolean doTask(String taskName, String taskArgs[]) throws
    PluginException;
    public String getVersion();
    public void init() throws PluginException;
    public void cleanUp();
}

The getVersion method must return the version number of the plug-in.

The init method must contain any initialization code.

The cleanUp method must contain any cleanup code.

The Migration Tool passes a command string and an argument array to the doTask 
method. The values that the command string and argument array must contain for 
different commands are listed in Table B–1.

Table B–1 Parameter Values for doTask Method

Parameters for the doTask Method Operation

command = "User_list"
arg[0]= "file=file_name"
arg[1]="domain=domain_name"

The plug-in generates a user list file for a 
specific domain in the specified file
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Any developer writing a plug-in should ensure that the plug-in accepts the 
preceding set of parameters. Various parameters on the command line are separated 
by a single space.

command = "User_profiles"
arg[0]="file=file_name"

The plug-in generates an LDIF file of all users 
on the source system

command = "Mbox_files"
arg[0] = "user=m_sourceuname"
arg[1] = "mbox_dir=m_mboxDir"

The plug-in generates an MBOX file for the 
user in the specified directory

command = "User_rules"
arg[0] = "user=sourceuname"
arg[1] = "dir=m_rulesDir"

The plug-in generates the rules XML file for the 
specified user in the specified rules directory

command = "Shared_folders"
arg[0] = "file=file_name"
arg[1] = "shared_folder_mbox_
dir=mboxdir"

The plug-in generates the shared folder file in 
the standard format in the specified file. MBOX 
files for the shared folder are generated in the 
shared_folder_mbox_dir.

command = "Distribution_lists"
arg[0] = "file=file_name"

The plug-in generates the distribution list file in 
the standard format in the specified file

command = "Public_aliases"
arg[0] = "file=file_name"

The plug-in generates the list of public aliases 
in the specified file in the standard format

Table B–1 Parameter Values for doTask Method

Parameters for the doTask Method Operation
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